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making communications 
accessible
All Ontarians have the same rights to communicate as individuals 
who are not living with a disability; rights that are protected by the 
Ontario Human Rights Code.

As a public organization, 
the City of St. Catharines 
has a responsibility to 
ensure we communicate 
clearly, effectively and 
equitably with all  
our residents.

The Provincial goal is a barrier-free Ontario by the 
year 2025. The Accessibility for Ontarians with 
Disabilities Act (AODA) will achieve this through its 
various standards which are being implemented in a 
phased-in approach.  

To provide good customer service and meet the 
AODA regulations, it is vital that the City of  
St. Catharines do its part to provide, where possible, 
documents in accessible formats. In cases where 
this is not possible, for instance a complex blueprint, 
the City must be able to provide the information in 
alternative formats (say, meet in person to describe 
the blueprint or other options depending on the 
individual’s needs). 

In 2021, the City is redesigning its website to meet 
the standards. Moving forward only accessible 
materials will be on the website, including 
documents that are linked for further information, 
and graphics, videos and social media posts will  
be accessible.
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Meeting Standards

The Information and Communications Standard section under the Integrated Accessibility 
Standard Regulation offers guidance to municipalities for providing accessible communication. 
The standards do not address specifics, such as font size. Instead they focus on the obligations of 
government and public and private sector organizations.

The City of St. Catharines, as a large designated public sector organization 
under the legislation, is obligated to:

 1   provide Provide or arrange for the provision of 
accessible formats for people living with 
disabilities upon request.

 2   consult Consult with the person making the  
request to determine the suitability of an 
accessible format.

 3   notify Notify the public that accessible formats  
are available.

 4   procedures Provide emergency procedures, plans or public 
safety information in an accessible format, 
upon request.

 5   ensure Ensure websites and web content conform 
with World Wide Web Consortium Web 
Content Accessibility Guidelines (WCAG) 2.0  
at Level AA as of Jan. 1, 2021.
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By the Numbers

 1   Statistics Canada estimates 
that by 2026 one of every five people living in Canada will be an older adult. As people age, they  
have greater incidences of hearing loss, low vision, cognitive impairments and lessened mobility  
and dexterity.

 2   In 2017, Statistics Canada reported 
that one in five (22 per cent) of the Canadian population aged 15 years and over – or about 6.2 million 
individuals – had one or more disabilities. And 1.5 million (5.4 per cent of ) Canadians aged 15 and 
over have visual impairment – 84 per cent of those individuals use one or more assistive devices. 
Further, it states the prevalence of disability increased with age, from 13 per cent for those aged 15 to 
24 years to 47 per cent for those aged 75 years and over.

 3   Add to this 
the 10 per cent of Canadians who have a learning disability and it is easy to see that in the future 
there will be an increase in the number of residents and customers who will require some kind of 
alternative format to access information from the City.

By providing accessible communications, we will increase the number of people who can access 
information. That is good customer service. 

Speaking of good customer service, remember the onus is on the City to provide communication in 
formats that are accessible to individuals with disabilities upon request. This should be done in a timely 
manner that takes into account a person’s accessibility needs and should not cost more than the regular 
costs charged to other persons. Never make a customer feel as if providing an alternative format is an 
inconvenience or suggest that it is too much work.
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By the Numbers, an infographic

1

by 2026

1/5
= older adult

living in
Canada

“As people age, 
they have greater 
incidences of 
hearing loss, low 
vision, cognitive 
impairments and 
lessened mobility 
and dexterity.”

2

(6.2 MIL)
individuals

22%
of the Canadian population

15 YRS
and over ^

has 1 or more disabilities

3

10%
of the Canadians have a 

learning disability

“there will be an increase in  
the number of residents and 
customers who will require some 
kind of alternative format to access 
information from the City”.

Source information provided by: Statistics Canada
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Communication Tools and Alternatives

It’s important to remember that there are several communication tools to consider when accommodating 
a request for an alternative format. Below is a partial list of communication tools.

In Person

Never underestimate the importance of face-to-face contact when trying to explain complicated  
concepts or ideas. Communicating in person will also allow you to read a person’s facial expressions so 
you can gauge whether the person understands. Remember that reducing the pace of your speech can 
improve communication.

Phone

It is an important tool in sharing information and staying connected. Remember to speak clearly while on 
the phone and try not to talk too quickly when leaving voicemail messages.

TTY – TeleTYpewriter (or TTY) 

Is an electronic device used for text communication via telephone lines by a person who has a hearing or 
speech disability. The City’s TTY number is 905.688.4TTY (4889).

Bell Relay Service

Operators assist in placing or receiving calls to and from people who use a TTY machine. The operator will 
also assist in placing Voice Carry Over (allowing a person living with a hearing disability to speak directly 
to the other party) and Hearing Carry Over (allowing a person living with a speech impairment to hear the 
other party) calls. The service is free for local calls.

Email / Text / Social Media 

These are all forms of electronic text communication using a computer or a smartphone. Widely used to 
communicate by individuals with or without a disability, these types of communication require a computer 
or smartphone and as such may not be practical for people who rely on public computer access.

Fax 

Fax machine usage has decreased significantly with the introduction of document scanning devices 
and access to PDFs (portable document format) However, it remains a viable way of sharing written 
communication pieces for individuals who may not be able to access them in person.
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Audio 

Audio recordings, in digital and physical formats, are useful for individuals who are unable to read, or are 
hearing or visually impaired. Text or screen readers can also be used to create an audio recording of written 
documents or webpages. 

Braille 

Using a series of raised dots, braille allows individuals with visual impairments to read printed material. 
Although the development of text readers has reduced the demand for this type of communication, it  
is still used by some. Producing a braille document requires a special printer and cannot be produced  
in house.

Sign Language 

Replacing acoustically conveyed sound patterns, sign language uses hand shapes, orientation and 
movements of the hands, arms or body, and facial expression to convey meaning.

Closed Captioning

A text transcription of the audio portion of a television or video program as it occurs. The text transcriptions 
can be either verbatim or edited and can include non-speech elements. Videos produced by the City’s 
Corporate Communications team always include closed captioning.

Descriptive Audio 

An additional audio narration of visual media products, including televisions, film, dance, opera and visual 
arts. The narrator talks throughout the presentation, describing what is happening. Although the narration 
is generally during natural pauses in the production, sometimes it can occur during dialogue.

LanguageLine Solutions

Translation for Customer and Guest Services - The City has LanguageLine Solutions which allows customer 
and guest services workers, both at City Hall’s Citizens First and the St. Catharines Kiwanis Aquatics Centre, 
to access interpreters representing over 240 languages to better assist the public over the phone and in 
person. To enhance customer service, tablets are set up at both City Hall and the St. Catharines Kiwanis 
Aquatics Centre. Via the tablet select languages, most critically sign language, can be accessed via  
video chat.
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how to make it accessible

Microsoft Word Documents

In order to be accessible, documents should be created using a well-structured Microsoft Word document, 
then converted into an Adobe Acrobat PDF document.

Documents must have a defined structure, i.e. title, headings, sub-headings.  During the conversion to PDF, 
Adobe creates tags from these style elements. These tags then become bookmarks describing the layout of 
a document, enabling a screen reader to navigate and read it correctly in Adobe.

Use plain language

Plain language is text that the reader can understand the first time. 

It sounds easy enough, but text is often cluttered with acronyms, jargon and complex sentence structure. 

Text that is clear and easy to read benefits customers living with learning disabilities 
and low literacy skills. It improves comprehension for all users and allows for easy 
adaptation to other formats. As a measure – documents should be prepared for a 
reading level of Grade 5 or 6. 

When writing in plain language remember to:

• Keep your intended audience in mind.

• Shorten sentences.

• Use everyday words.

• Eliminate jargon.

• Use simple sentence structure and grammar.
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Start with a new template

The main City templates have been updated to ensure accessibility, so it is imperative to always create a 
document from a new template. If there are documents specific to your department that require updates, 
please connect with Communications for assistance. Using a new template will also ensure you are using 
the most up-to-date version.

Choose sans serif fonts

The type of font makes a big difference to a document’s readability. 

Generally, sans serif (without serifs) fonts are the easiest to read and are considered the most accessible, 
with a few exceptions. Serif fonts are more decorative in appearance, which can make them difficult to  
read (Figure 1). Newer City templates are typically pre-populated with accessible font styles for headings 
and body copy.

Serif Times New Roman font, note the  
decorative features on the font

Sans Serif Arial, very simple,  
clean font

Figure 1: Font type examples

Avoid condensed versions of these fonts as squeezed lettering decreases spacing between characters, 
reducing readability. Also avoid using highly decorative and handwriting-style fonts.
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Size matters

Size is critical to accessibility when it comes to written communications.

A font size between 12 points and 14 points is recommended for the main body text in a document. 
However, it is important to remember that not all fonts are the same size. To demonstrate, both fonts below 
are 18-point, but clearly Calibri font is smaller than the Tahoma font, as seen below. (Figure 2)

St. Catharines 
Calibri Regular 
18 point

St. Catharines
Tahoma Regular 
18 point

Figure 2: Font size examples

Between 16-point and 18-point font size is considered large print and 10-point and less is not accessible. 

Italicizing and underlining fonts should be avoided. An exception is made for live email and website links in 
an electronic format or online. 
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Avoid stylizing fonts

To emphasize a particular word or heading, use bold text with both upper- and lower-case letters. The 
use of all capital letters should also be avoided. A person’s brain can more easily recognize words when 
characters go above and below the centre line of text.

Tracking refers to the space between each character. Tight spacing, particularly in smaller text sizes can 
diminish legibility. Added white space around the characters allows the individual characters to emerge 
and be recognized more quickly. However, too much space can cause the individual character to become 
isolated, diminishing readability. 

Monospaced fonts can be used to ensure proper tracking. Monospaced fonts are fonts in which all the 
letters and characters each occupy the same amount of horizontal space. 

Make white space your friend

As important as the right font and size is in achieving an accessible document, so too is the amount of 
white space on a page. An adequate amount of space between lines of text and the amount of space 
between individual characters will increase its readability.

Leading, or the spacing between lines of text, should be at least 25 to 30 per cent of the font’s point size. 
This is because many people with partial sight have difficulty finding the beginning of the next line  
while reading.

Additionally, leaving a space between paragraphs is helpful for individuals with low vision. Do not make 
page spacing by repeatedly pressing “enter” for extra space. (Figure 3)

This is an adequate amount 
of space between lines of text.

The amount of space between 
individual characters will 
increase its readability.

This is not an adequate amount 
of space between lines of text.
The lack of space between 
individual characters will 
decrease its readability.

Figure 3: White space examples
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Colour me accessible

Colour and contrast are important elements in making a document accessible. The better the contrast 
between the background and the text, the more readable it will be.

Black text on a white or off-white background provides the best contrast. However, there are other options 
that meet the acceptable contrast levels without always resorting to black and white.

There are several online tools to help you select accessible contrast and colour combinations. These handy 
tools will assess if appropriate contrast has been achieved.  
Contrast Checker: contrastchecker.com

Align left

Do not condense or stretch lines of text. It is recommended that text align to the left margin as it is easy to 
find the start of the next line and keeps spaces even between words. Justifying should be avoided because 
it causes uneven spacing between words.

Use styles for headings

Styles in Microsoft are useful to help organize information and make documents easier to understand.

Be sure to use styles instead of using the character formatting, which serve as a structural element in a 
document. This makes it easier for people using screen-reading technology. 

Additionally, using standardized styles in all documents makes it easier for everyone to navigate  
City documents.

When using styles, remember to use them in the correct numerical order, using the Normal style as the 
style body text. The largest style will be Title, following by Heading 1, Heading 2 and so on. 

Use headings in descending order:

• Normal: Use for the body content of the document.

• Title: Use as the main title or name of document.

• Heading 1: Use for main section titles.

• Heading 2: Use for the first subsection in a main section, etc.

• Use at least one heading in each document.

https://contrastchecker.com
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St. Catharines Default Styles

The following fonts, font sizes, font colour have been chosen  
as the City of St. Catharines corporate standard. 

St. Catharines Title 
Arial 22pt Bold, Blue

St. Catharines Heading 1 
Arial 18pt Bold, Black

St. Catharines Heading 2 
Arial 16pt Bold, Black

St. Catharines Heading 3 
Arial 14pt Bold, Black

St. Catharines Heading 4 
Arial 12pt Bold, Black

St. Catharines Normal 
Arial 12pt, Black

Figure 4: City of St. Catharines styles
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Style Application

To apply styles:

1. Highlight the text (Figure 5)

2. Select the Home tab. (Figure 6)

3. Select styles group and set the  
proper style. (Figure 7)

To apply styles to multiple text 
throughout the document 

1. Highlight the text.

2. Hold down the <Ctrl> key.

3. Use scroll bar or up and down arrows 
to navigate throughout your document 
then highlight each heading.

4. When done, release the <Ctrl> key then 
select the proper style.

Accessibility

Figure 5: Highlight text

Accessibility

Figure 6: Select home

Accessibility

Figure 7: Select style
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Add alternative text

Alternative text or alt text is a description of a photo, image or graphic. Assistive technology reads this text, 
allowing the user to understand what photos and images are being used, even though the person may not 
be able to see them.

Alt text should describe what information the image is conveying, replicate any text contained in the 
image and should ideally be no more than a sentence in length.  There is no need to include superfluous 
context descriptors such as “image of” or “photo of” within the description or alt text.

To add alternative text to pictures

1. Right click on the image then select Edit Alt Text

2. For Description, enter a description of the content. (Figure 8)

Figure 8: Alt Text
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Tables and charts

Tables and charts can be made accessible! But, 
a few things need to be done to ensure it can 
be read properly by a text or screen reader.

To make tables accessible

Keep tables simple by avoiding merging cells 
or splitting cells.

Screen readers read tables row by row across 
columns so the table should make sense when 
read from left to right.  To test this, select the 
first cell and press the <Tab> key repeatedly 
to make sure the focus moves across the rows 
then down the next row.

Ensure table headers are repeated on 
subsequent pages to help readers follow the 
flow of information.

To repeat header rows and add alt text:

1. Highlight the header row and right click.

2. Select Table Properties. (Figure 9)

3. Select the box next to ‘repeat as header 
row’ and deselect the box that says ‘allow 
row breaks across pages’. Before leaving the 
Table Properties menu, go to the Alt Text 
tab. Add alt text and click OK. (Figure 10)

For charts, simply right click on the chart and 
select edit alt text within the menu to provide 
a description. For a complex chart, it is best 
to highlight the information within the body 
of the report (say under the table) so people 
don’t have to rely purely on the image to 
garner the information.

Figure 9: Table Properties Row tab

Figure 10: Table Properties Alt Text
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Use a table of contents

A table of contents is necessary to navigate large documents for everyone, not just persons with a 
disability. As the author, you have to decide on what headings to include then apply an appropriate 
heading style to it. You will need to do the following:

• Insert a page break before your content to ensure the table of contents does not include the  
page number 1

• Add page numbers.

• Insert a table of contents.

To insert a Table of Contents:

1. Position the insertion point  
where you would like to  
insert the table of contents.

2. On the References tab,  
in the Table of Contents  
group, select the Table of  
Contents icon. (Figure 11)

3. Select Custom Table  
of Contents.

4. For Tab leader, from  
the drop-down menu  
select None. (Figure 12)

5. For Show levels:  
change to 4.

6. Click the OK button

Figure 11:  Steps to insert a table of contents

Figure 12:  Steps to insert a table of contents
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Update a table of contents

You will need to update your table of contents as you add and remove content.  It will not  
update automatically.

1. Right click on the existing table of contents, select Update Field.

2. Select either Update Page Numbers only if you add text or Update Entire Table if you added new 
headings to your document.

3. Click on the OK button.

Explain graphics, tables, charts and maps using text

All graphic elements that contain information relevant to the document require a text explanation (along 
with alt text).

When explaining complicated visuals, be sure to identify the type of visual (chart, graph, map, etc.) along 
with the title, purpose and the meaning of the data.

It is not necessary to provide a separate text explanation if one already exists in the text of the document. In 
this case, make reference to the visual in the text of the document.

It is also unnecessary to provide text explanations for graphics used for visual appeal, such a designer lines, 
borders etc. Decorative elements can also be tagged as such, by right clicking and selecting edit alt text, 
then checking the box to mark as decorative.

Photographs also used for visual appeal and not having a great deal of relevance can be given very short 
descriptions. Avoid using text boxes for text, graphics, tables or charts.
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Add a document title 

A document title is not the same as a document name. Descriptive and meaningful titles are important in 
case the document is converted to HTML and PDFs for accessibility purposes. Please note: even if the title 
has been added in Word, it might be flagged by the accessibility checker in Adobe Professional. Individuals 
with only Adobe Reader can reach out to Communications division for assistance.

To add a title to the metadata of your document: 
(Figure 13)

1. On the File tab, select Info.  

2. Find the Title fillable box on the right and type in an appropriate title.

Figure 13:  Adding a document title



how to create accessible documents  |  22 

  accessible stc 

Online accessible forms

All forms placed online should be fillable – meaning any user can fill out the information without having 
to print the form and fill it out by hand. Except in situations where an applicant must attend City Hall in 
person, forms should be able to be submitted via email. Some additional services will be available online 
with an updated website and this makes services more accessible.

Use the Accessibility Checker in Microsoft Word

The Accessibility Checker helps users create more accessible content. By identifying areas that might be 
challenging for users with disabilities, you can fix potential problems with your content. This feature is 
available in Microsoft Word and will only work on documents saved as a .docx file.

The Accessibility Checker reviews your document against a set of possible issues. Each issue is classified as 
an Error, a Warning or a Tip. These issues are described as:

 1   accessibility error An accessibility error is given for content that 
makes a file very difficult or impossible for 
people with disabilities to understand.

 2   accessibility warning An accessibility warning is given for  
content that in most, but not all, cases  
makes a file difficult for people with  
disabilities to understand.

 3   accessibility tip An accessibility tip is given for content that 
people with disabilities can understand, but 
that might be better organized or presented in 
a way that would maximize their experience.

Whenever the Accessibility Checker finds an issue, the task pane shows information about why the 
content might be inaccessible. When you select an issue, it shows you how to repair or revise it.
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To use the accessibility checker:

1. Click on the Review tab.

2. Click on Check Accessibility. (Figure 14)

3. Using the Inspection Result pane, to the right, select the issue to learn more and fix the error

.

Figure 14: Check Accessibility 

Use the Adobe PDF Maker add-on to create a tagged PDF

Using the Adobe PDF Maker in Microsoft Word is an easy way to create a tagged PDF, which will be easy to 
navigate for individuals using screen reading technology.

1. In Microsoft Word, save the accessible document.

2. On the Acrobat tab in Word, select the Create PDF icon. (Figure 15)

3. Browse to the appropriate location and specify a filename.

4. Click on the Save button.

Figure 15: Create PDF
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Adobe Professional

Staff members with Adobe Professional 
(as opposed to only Adobe Reader) do 
have the ability to edit PDFs and run the 
Accessibility Checker in Adobe. 

To run the Accessibility Checker in Adobe, click on 
Tools and in the righthand column click  
on Accessibility. 

If you do not see the accessibility icon in the righthand 
column, then scroll down and select Accessibility 
within the body of the document and click open. 
(Figure 16)

Now you will see the accessibility tools are available for 
use with your PDF document and you should see the 
following icon,  added to the righthand column. 

To get Adobe to run its Accessibility Checker, click on 
Full Check. When you see another pop-up window, 
click on Start Checking. (Figure 17)

Figure 16: Accessibility

Figure 17:  Accessibility Checker Options
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Once the scan of the document is complete, a 
window will pop up on the left-hand column and 
appear similar to (Figure 18).

You can expand each of those issues for more 
information by clicking on the arrows to the left. 
(Figure 19) Once those features appear in the 
column, it will allow you to learn more about the 
errors and depending on the error, make a quick 
fix or learn more about how to manually correct 
the error.

Now, if you right click on those failed items, you 
will get another pop-up window. That pop-up 
window typically (but not always) includes: Fix, 
Skip Rule, Explain, Check Again, Show Report  
and Options.

If Fix is an available option in this menu, click on it 
– it will allow you to make corrections to that item. 

When the Fix option is not available, you can 
either go to Explain, which will link you to the 
Adobe website for more information, or click on 
Show Report, which provides a more in- depth 
report (in the left-hand column, replacing the 
original accessibility report) and hyperlinks that 
bring you to specific sections of the Adobe 
website that explain how to manually update 
each of the errors that have been found in the 
document (by clicking each hyperlink related to 
an error in the accessibility report).

Figure 18:  Accessibility Checker report

Figure 19:  Accessibility Checker issues



how to create accessible documents  |  26 

  accessible stc 

Microsoft Word  
accessibility checklist
Making documents accessible benefits all users so it is a good practice to follow  
in general. The following checklists are a quick reference to ensure accessibility.

 Use plain language (middle-school level, Grades 5 or 6).

 Choose sans serif fonts such as Arial with a minimum 12-point font size.

 Use styles when formatting rather than character formatting  
(individually changing fonts and sizes)

 Use navigational aids such as links, bookmarks, styles and a table of contents  
because these can be accessed using a keyboard without relying on a mouse.

 Use white space, but do not use more than 2 paragraph returns  
(strokes of the Enters key), use paragraph before and after spacing instead.

 Use contrasting colours.

 Use at least one heading style for every document.

 Add alt / description text for photos, images or graphics  
(do not use the words “image of” or “photo of”).

 Make tables accessible –keep them simple, avoid merging cells,  
use repeat header rows, add alt / description text.

 Avoid text boxes for text, graphics, tables or charts.

 Avoid underline except for electronic links (email, website, etc.).

 Avoid using all CAPS and italics.

 Use a table of contents for large documents.

 Use bullets or numbered bullets for important points.

 Add a document title.

 Use the accessibility checker.
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Adobe Acrobat PDF 
accessibility checklist

 Generate the PDF file.

 Make sure the document has searchable text, not scanned text. 

 Run the Accessibility Checker and fix any errors as required.
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